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Copyright

This is a fully copyrighted work, protected under the copyright
laws of the United States of America.

You may copy this software for your personal use only,
Duplication for any other purpose constitutes infringement of

copyright laws and is a crime.
The artwork included with The Comic Strip Faclory is

copyrighted by the artists. You may publish this art in comic strips
created with The Comic Strip Factory without paying any additional
foes, as long as the following notice is included:

“Copyright ©1986. (Some of) the art in this comic is
copyrighted by Trici Venola and Kurt Wahlner.”

Limited Warranty

This program is provided “as is” without warranty of any kind.
You assume the entire risk as to the results and performance of the
program. If the program is defective, you assume the cost of all repair
or correction,

Also, Foundation Publishing does not warrant, guarantee or
make any representations regarding the use of, or the results of the use
of, the program in terms of correctness, accuracy, reliability, or
otherwise, and you rely on the program and results at your own risk.

Foundation Publishing does warrant that the program disk(s)
are free from defects in materials and workmanship under normal use
for a period of ninety (90) days from delivery as evidenced by your
receipt,

Foundation Publishing’s entire liability and your exclusive
remedy is replacement of the disk(s) not meeting Foundation
Publishing’s limited warranty. Defective disks should be returned to
Foundation Publishing with a copy of your receipt.

Updates
To obtain updates to this product, you must complete and return
the enclosed Registration Card to Foundation Publishing.

6436 City West Parkway

HT' ‘ Minneapolis, MN 55344

(612) 942-2925




Comic Strip Factory, Copyright © The Pacific BitWorks, 1986.
Comic Strip Factory User's Manual, Copyright © Foundation Publishing, Inc., 1986.
First Printing September 1986.
Printed in the United States of America.

Comic characters included with Comic Strip Factory are Copyright © Trici Venola,
1986. Comic backgrounds included with Comic Strip Factory are Copyright ©

Kurt Walhner, 1986.

The Comic Strip Factory User's Manual was formatted with Microsoft Word.
Camera-ready copy was produced on the Apple LaserWriter Plus.

Comic Strip Factory is a Trademark of Foundation Publishing, Inc.

Finder; System; and Imagewriter Driver aré copyrighted programs of Apple
Computer, Inc. licensed to Foundation Publishing, Inc. to distribute for use only
in combination with Comic Strip Factory. Apple software shall not be copied onto
another diskette (except for archival purposes) or into memory unless part of the
execution of Comic Strip Factory. When Comic Strip Factory has completed
execution, Apple Software shall not be used by another other program.

APPLE COMPUTER, INC. MAKES NO WARRANTIES, EITHER EXPRESS
OR IMPLIED, REGARDING THE ENCLOSED SOFTWARE PACKAGE, ITS
MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.
THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME
STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS
WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY
g% A%T:ER RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATETO

Apple is a registered Trademark, and the Apple logo, Macintosh logo, The
Finder, MacPaint, MacWrite, LaserWriter, and Switcher are Trademarks of Apple
Computer, Inc. Macintosh is a Trademark of Mcintosh Laboratory, Inc. and is U
by Apple Computer, Inc. with its express permission.

Microsoft Word is a registered Trademark of Microsoft Corporation.
MockWrite is a Trademark of CE Software, Inc. SideKick and NotePad+ are
Trademarks of Borland International.
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“ theater managers started talkin’ to me in word
balloons that had been customized with Editbits so they
had thern Tittle icicles hangin' off ‘em.. oh, you can tell.."
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k‘g{‘& FROM NATCHEZ TO

‘ MOBILE...FROM MEMPHIS TO
PALM SPRINGS..
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How about that
Polly , ladeez and
gennemumm...and

d "We regret that
your abilities no
| longer suit ourx

now , let's hear an e needs at the
encouraging
welcome for a
sentimental +| be kept on file!

former favorite
looking to hit the
comeback trail. ..

Broadway

YER ALL SCOM! VAMPIRES!|  |by

4 HOPE YOO ALL DIE! COME ON UP EX2Y
HERE, | DARE YOO! YEAH, YOO

L™ TALKIN' TO YOO!

A. Mexd"

“Ya have to know when to
9 1eave.. when the magic is
gone...a seasoned performer
kin sense it in a thousand
different ways...subtle things. ..
oh, you know , believe me..."

Aw, gidaddahere!! [
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ARE YOO
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1 AW, HAVE A HEART, BABE.
1 THAT JONGLE JOST WASN'T
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1 WAS WITH A USO TROUPE; |
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HEY, WHERE YA GOIN?!
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> YOU'RE TRAVELING
THROUGH ANOTHER
DEMENTIA .oy N

HEY, WEREN'T
\OU THE THEATER
MANAGER?

"A "CHONK-STYLE' MATTER
TRANSPORTER?" | SAID,
"HOW GOOD COULD THAT
BE?2" "WHO CARES?" HE
SAID, "IT'S ON SALE.” "WELL
SOREITIS,” | SAID...

REALLY? TAH/S
WHACKY GIZMO?

THIS "WHACKY
GIZMO', EARTH~
BUG, IS MY MOST

TTHE ARTIST ONLY HAS |
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D

ISK FINISHED, GIMME NOW BEGINS AN
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AH, YOU HAVE
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THAT WHICH CAN
;4 DELIVER TO ME MY
HEART'S DESIRE,

#  ORVICE VERSA.

YO, WIZ. GOTCHER
ORDER--SIGNED,

FORITS SAFE
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= MY TICKET TO

POWERFOL TOOL
OF CONJURATION.
IT WAS TAKEN
FROM ME IN AN
EVIL NETHER-
WORLD IN THE
COURSE OF A
GAME OF
CHANCE.
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Srd By Light Yeari!
"Hero of the Asterotd!”

PEQPLE ALLOS TOLD
ME... BE CAREFOL
WHATCHA DO...
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"And | owe 1t all to Comic Strip
Factory! God love ya fellas. |
mean thet sincerely.




We Know You're Not Going To Read This

And we understand. Already, you probab(ljy know what you've
got here. You know what it means to suddenly have the
camera, the crew, the sets, the props, and the actors all in
place, awaiting your direction. You appreciate the potential of
the graphic story medium. We know, then, that there’s
nothing to keep you from:

Trying To Do It All At Once

Yes: You're going to start writing before you've got a story, and
torture the panels (those boxes where comics happen) into
strange and unnatural shapes, and throw in characters without
a thought as to what to do with them. Go ahead. We'll wait for
{ou here. But before you go, we urge you to at least peruse this
asic rhythm system to keep your errant doodling from

boggingbdown and collapsing entirely right at the start, causing
%’ﬁle—l vfz%l : ellow “No fun! Dumb program!™ and hurl the disk at

1. From the title pa%e, select the File menu and select
New Comic Strip.

2. ?lfgiiurlltg ;g:llsit the page parameters by pressing Return or

3. From the File menu, Open Parts.

4. Select a Parts file that looks interesting.
Trying to Do It All At Once




5. Shift-click over several character body parts.
6. From the Panel menu, choose Copy to Panel

7. Arrange parts in the panel in an aesthetically pleasing
fashion. From the Arrange menu, use Bring to Front
and Send to Back to place hats firmly on heads, canes
in hands, one character behind another, and so on. If
one part refuses to go in front of another part, try
selecting the one in front (that you want in back],
selecting Restrict to Panel from the Arrange menu,
then sending it to the back or bringing the other to the
front.

8. Repeat steps 5, 6, and 7 until the panel is completed to
your satisfaction.

9. Choose Add Text from the Objects menu and mess
around with words.

10. Choose Background Pattern from the Panel menu
and mess around with patterns.

o |®

11. Choose Install Background from the File menu, select
a file from the dialog that comes up, click OK, move the
animated panel shape around in the background
window, and choose Copy to Panel from the Panel
menu.

53

12. Admit that this is going nowhere and stop messing
around.

13. Instead of drifting off to TV Guide, read on.

Ready to Do It the Right Way?

Good. We'll start with a little background, though not the
scenic variety. (Pages fly off the calendar as though caught in a
gale, or a really big fan, and...)

In big-time comics, since time immemorial (the 1960s), the
Act of Comic Creation has gone something like this: A Writer
turns in an outline to a Penciller who draws a layout of panels
and rough art and gives it back to a Writer who scripts dialog
and captions and gives it to an Inker who finishes the art then
gives it to a Letterer who puts all the words where they belong.

@ Comic Strip Factory User Manual






Set initial layout
for this document:

r = a| O1
|[ :|| @ 2
L[ =\ Jl O3
04
O1 02 ®3 OA4
OTall @ Wide

[ Cancel ) ([ 06K |

For more extensive panel modification, use the commands
Add Rectangle, Add Oval, and Add Triangle in the Panel
{@ menu. Or click on one of the three leftmost icons on the icon

bar, which correspond to Add Rectangle, Add Oval, and
Add Triangle.

While we're on the subject of icons and menus: from now on,
when we mention a command, we'll use its menu item name,
and tell you which menu it's on. Some commands have both a
menu item and an icon in the icon bar. For these, we'll show
the icon in the margin next to the paragraph where the
command is mentioned. Whenever you choose a menu item,
its corresponding icon (if there is one) will invert. This helps
you learn which menu items are duplicated as icons.

An important note: The icon bar doesn’t contain additional
commands. Every icon has a corresponding menu item. The

icon bar exists only for your convenience; a quick way to issue
commands with a single click.

Panel menu | Objects menu ‘Arrange menu

e e R EN I € B

Add Rectangle @ Add/Edit Text Bring to Front
Add Oval @- Edit Bits/Create Part Send to Back
Add Triangle @ | Duplicate
Background Pattern Invert
Copy to Panel 28| Flip Horizontal

_@ Flip Vertical

[€] Rotate

& Comic Strip Factory User Manual




ram. The most important thing to remember ‘
Back tgl ﬁghgg;%g is that shapes are added to the current

in palnshape- when you add a shape, the added shape outside ‘
ane anel becomes part of the panel's new boundary.

gzﬁa%:ﬁegtagels are modified to fit the reshaped panel like ’
pieces of a jigsaw puzzle.

n em layout of panels, select the upper left
’I‘;}r’] é} ‘\%t?nayou cﬁtgk 1r}1’side the panel, it will highﬁght. Now
choos'e d Oval from the Panel menu. An animated outline
of an oval appears inside the panel. Grab the outline by the
“handle” in its center: put the cursor over the black box in the
oval’s center and hold down the mouse button. Now drag the
handle halfway between the current panel and the next panel.
Now click the OK button in the icon bar. See what happens?

Ee————— Untilled ==

3 7

|

Shape is added
to selected panel..

..and subtracted
from others.

It's possible to return a panel to its original shape by selecting
each of the panels that border on it in turn, choosing Add
Rectangle, then clicking OK. If you've made extensive

chan1 es to the panel, you may have to do the same thing to the
panel itself, and you may also have to adjust the size of the
rectangles you’re adding.

If you hold down the Command key (the key to the left of the
:ﬁice bar with the cloverleaf SYmbgl) Whil:};ou click OK, the
allogrz ‘;'%ILIE %%dﬁi tg the llayo%\t, as a separate panel. This

€ els. i
many interesting pane effegts. th practice you can achieve

Layout







Here are the choices:

e Panorama backgrounds are formed by dividing the fi :
three horizontal strips, then matching the strgips en(ljeti)nto

end.

« Wide Screen backgrounds are similar, but are divided fi
Y t
into two strips representing the top and bott e
a standard MacPaint page. > om halves of

e Portrait backgrounds are standard MacPai
haven’t been altered. int files that

The dialog box gives the dimensions for each t
background files. ype of

Note: If you create a panel that's larger in either dimensi
thatn tge E){agikgr O;r.ld ttl}xrpte you’\l/e bChOSCH. you won’t be SHIE to
put a background in that panel, but will be limited, i
background patterns. imited, instead, to

Backgrounds

| ——










reate another panel with a background picture
11;110?{. S(:Slz?éc?rB%ckground Papttern again, and click on the to
darken backfround radio button. Do the same, with yet
another panel, but selecting to lighten background. .Select
another panel, choose Background Pattern one last time,
uncheck the box next to Use Pattern, and click OK. Compare

your results in the different panels.

Experiment with this feature to see the many effects possible.

0

Untitled

To eliminate a background (picture and pattern) from an
individual panel, choose Background Pattern... from the
File menu. From the Pattern dialog, choose the blank (white)
pattern as the background; this eliminates the previous
background.

Balloons, Captions, & Scripts

There are two ways to enter text for balloons and captions.
Following the method outlined under Ready to Do It the
Right Way?, you could prepare an entire script ahead of time
in any word processor that saves text-only files. You can also
use a text editor desk accessory like CE Software’s
“MockWrite” or SideKick's “NotePad+.”

The Open Text... item in the File menu of Comic Strip
Factory lets you a open text file to copy dialog between it and
the balloon editor. You can also create a new script in Comic
Strip Factory using the New Text item in the File menu. Or,
you can enter and edit all text in the balloon editor itself.

There’s an advantage to writing your scripts beforehand. You

can then start on a page of empty panels, create all your dialog
balloons, and place them roughly where you want them on the
page. This way, you'll know whether the script needs padding

Comic Strip Factory User Manual



age (or larger panels or a smaller page) or

tohﬁtlilgxl:l Eimthlggpn%eds to be cut to make room for pictures. If
L qre doing a multiple page comic book, you can make sure
i ly placed to keep readers turning

are strategica
pun:sh lj(rllcfrsnic Strip Factory doesn’t force you to work this way,
v find that work proceeds faster if you first “lay

gg:vgot‘—l‘qén Si"alo&" then add, remove, and reshape balloons to
fit the pace of the action, then put the characters in place.

But dialog balloons are more than just letters, spaces, and
punctuation. The format of each balloon, and the style changes
in the balloon, are important to the look of the comic strip. To
establish these elements, you have to take your text from the
simple lines-and-paragraphs environment of the text window
into the balloon editor.

For a guided tour of the balloon editor, Choose Add Text...
@ from L%e Parts menu. You'll see the balloon editor take over

the screen and activate the icon bar's OK and Cancel buttons.
On the left of the screen under the icon bar is the text entry
area, with a cursor, scroll bar, and a size box (under the scroll
bar). The size box makes the text area narrower or wider.
Drag the size box as you would the size box of any standard

window.
" & Ffite Edit Panel JOIAG Arrange Windows

] PR eGR4 ] 2, 16| % B B 0K

L
A CHONK STYLE MATTER K%
TRANSPORTER?"” | SAID,
"HOW GOOD COULD THAT
EE?" "WHO CARES?" HE
SAID, "IT'S ON SALE!"
"WELL SOREIT IS," | SAID...

ol
[ cut [ copy ][ Paste | Santa Monictu @@
Times
l;Erl L:; Uen!i’ce ( Plain J(@derlinﬂ
@ 5= —] |Venice Beacl| ( Bold ][ Outline
b‘%lll- (setegnt ] [ Italic JrShadow__]J

Below the text area are three buttons: Cut, Co d

; . y py. an Paste.
gli(ittse behave just like Cut, Copy, and Paste commands in the
editoxr_genu of most Macintosh word processors and text

Balloons, Captions, & Scripts




eneath and to the left of the Edit buttons are
{?r?: ?::%giyt}?at control the thickness of balloon lines. The far
left icon makes the balloon outline invisible. The center icon
gives the balloon a one-pixel wide outline; the far right icon
makes the balloon outline two pixels wide.

ight of the “line” icons are three icons to control text
jrlfsttilllifc:aii%n. The right icon sets “flush-left”: text that's flush
on the left margin, but varied on the right margin, like a page
typed on a typewriter. The manual youre reading is set
ragged-right. The center icon sets centered text—the default
setunF. The left icon sets text “flush-right”; the opposite of
eft.

flush

Underneath these icons, at the bottom left, are a row of icons
to select the balloon type. The balloon types range from
bumpy “thought” balloons to a plain rectangle, useful for
captions and exposition. Any balloon type can be given a
“pointer” but we're getting ahead of ourselves. Click any of
balloon icons to select a balloon type.

To the right of the balloon icons is a Fonts menu and a group of
buttons to control text size and style. Select a font by clicking
its name (use the scroll bar if necessary), then clicking the

Set Font button. Text entered after clicking Set Font will be
displayed in the selected font. To change some or all the text
you've already entered, select the text then change the font.
This is done as in MacWrite: click and dra§ over a range of text
0{1 double-click to select an individual word. First select, then
change.

The same is true for size and style changes, which are made
using the buttons to the right of the Font menu.

When you've finished with the changes and additions for your
balloon, click the OK button in the icon bar. Or click Cancel
and return to the comic window without making changes.

Tip: When putting words into a comic strip, don't describe
what your pictures are showing. Dialog in comics is for
communication between characters; captions are for
exposition and narrative. The use of boldface or other style, or
even a different font, on selected words keeps your characters
from speaking in a monotone. Watch a television newscast
and listen to the way the anchorpeople talk. That vocal rise
and fall and emphasis on every seventh word is something

they learn in famous broadcaster's school It keeps your
attention. But dom't overdo it.

Comic Strip Factory User Manual
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, it out. Start from scratch: back in the main program
ggﬁjegywith just a comic window open. Choose New Te%:t
from the File menu. Type “This is a test.” Now select the
text and choose Copy to Panel from the Panel menu. The
palloon editor window appears with “This is a test.” centered
on the top line of the text area. Select the entire sentence,
click the Copy button, then click Paste three times.
Experiment with the size box in the lower right corner of the
text area. Grab it and move it back and forth; notice the effect
on text in the window. Try out the flush right and flush left
icons, immediately under the Paste button.

ble-click on the third “test” to select it; it will be
displayed inverted. Next click Chicago in the scrolling Font
menu at the screen’s bottom and click the Set Font button.
Select the last “is” in the text and click the Italics button.
Finally, move the cursor to the end of the text, set the font to
Monaco, click the 9 button for nine-point type and type “end
of test.” Now select a balloon type, and make sure it has a
visible outline. Click the OK button in the icon bar.

Now dou

The balloon will appear in the current panel, with a selection
marquee around it. To give a selected balloon a pointer,
choose Point Balloon from the Objects menu. A special
point-balloon icon will appear, along with an outline of the
pointer. Notice that the balloon pointer always starts from the
center of the balloon. Move the cursor around until the

ointer “points” where you wish, then click the mouse button.
Note: vou can Cancel Point Balloon without adding a pointer
by clicking on the balloon or outside the window).

fe——————— Unlitled =

Hey! You aren't
supposed to be

Additional pointers can be added by selecting the balloon and
ctﬁoosing Point Balloon again. You can remove all pointers or
% ange a balloon entirely by selecting it, then choosing Edit
ae:;l... in the Objects menu. The balloon editor will appear
: 1% with the text and current settings in place. Change

lr:a.sr? as needed or desired. Or click OK without making any
changes to eliminate all pointers. Easy, huh?

Balloons, Captions, & Scripts




lloon can only make straight pointers. If you want Lo
ggfrgttrﬁﬁlght bubbles goming down from thought balloons, or if
ou want curvy or ja ed pointers, a sampling 91’ sgch is
available in the parts lile “Bubbles & Pointers.” It's also very
easy to make your own bubbles and pointers with MacPaint and
import them using part Maker or the Scrapbook.

words & Characters

Even if you're an accom lished computer comics artist, Comic
Strip Factory is invaluable as a framework tool, and for the ease

of layout and lettering it provides.

But maybe you're not a accomplished computer comics artist,
and bought Comic Strip Factory to give your literary instincts a
better showcase than your artistic abilities, alone, provide. If
so, you're limited to the Parts files available on these and
subsequent disks to vent your urge to self-expression.

Fortunately, it's not limiting, because any MacPaint-based
image can be used by Comic Strip Factory (see the "Part
Maker” section for details). But this program presupposes
that you have a tale worth the telling and the ability to tell it.
We can't supply ability. And the telling is a matter of taste and
inspiration. As you start putting the pictures in panels, they
may suggest things to you that change your story. The
characters may overwhelm the story and take everything
somewhere else. You may decide you don’t need words and
can tell it in mime. There's just no way of knowing: This is
New Stuff. Let it happen. Have fun. Be happy.

Customizing & Cleaning Up

The fine points of parts and balloons can be cleaned up using

the EditBits command in the Objects menu. The EditBits
Sommand lets you modify both the comic object and object’s
background mask.”

Think of the background mask as a small sheet of paper where
the object is drawn. The mask blocks anything behind it from

coming through. To make a convincing doughnut, you'd make

sure the background mask didn't cover the hole. at way, the
background would show through the hole.

Here's how to do it. Select an object and choose EditBits
from the Objects menu. On the window's left you'll see four
MacPaint-style tools. These function as in MacPaint: the hand
moves the image around, the pencil changes (draws or erases)
single pixels, the paint brush paints a larger area, and the
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rases. Below these tools, though, are two additional
gg?:cetl;o%s. These determine which pixels can be edited. With
the top button selected, you'll be editing the white background
mask pixels. The bottom button lets you edit black pixels of an
object. The gray area is the default; it represents the

background.

M ]
e e
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Note that black pixels can only be drawn on the background
mask. If you want to “add on” to a part or a balloon, you’ll have
to draw the mask area first. This needn't be precise, and you
can erase unneeded mask bits after you've drawn the black
bits. But be sure to leave a border around an object, about one
pixel wide, so it stands out from the background. And it's good
to erase some of the mask where a part touches another
part—a border between a head and torso, for example.

There’s a regular-size image of the obfect at the upper left to
%uide you as you work. e image will change to mimic your
ditBit changes. Click Cancel to throw out changes you've

made, or OK if everything's cool and you want the changes
incorporated.

Note: EditBits can also be used to edit balloon pointers, and to
give balloons nifty special effects like “icicles.” You can edit
only the outline of a regular balloon. To edit the black bits,
ghoose MergeBits in the Parts menu. MergeBits converts a
balloon into a part. The text inside the balloon can no longer

e edited, however, nor can the balloon be changed further

Customizing & Cleaning Up
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you access to the

“freezing” your

except with EditBits. MergeBits gains
hen to “merge” and

black bits of EditBits at the expense of
balloon text. Experiment to determine W

when not to “merge.”

Rolling Your Own Parts

We've provided you with a raft of ready-drawn art, but you'll
probably want to import your own graphic creations, or use
aphics from other packages and programs. At the simplest
evel, art can be copied to the Clipboard or Scrapbook then
pasted into an existing or new parts file, or directly into a
comic strip. The object can then be cleaned up in EditBits.
From MacPaint, the best way is to copy the object using the

“lasso.”

Switcher is great in these instances. Ideally, you can create a
Switcher “set” of Comic Strip Factory and MacPaint (or
another paint program.) Then you can draw objects as needed
and quickly move them to Comic Strip Factory. (In Switcher,
Comic Strip Factory requires 320K.)

There are a number of graphic desk-accessory tools that you
can use with Comic Strip Factory, but none of these uses the
lasso, and none let you edit what you grab. Still, they're useful
in a pinch: copying clip-art at the last minute, for example.

We've also provided a utility program, Part Maker, that works
with standard MacPaint files. Part Maker converts graphics in
clip-art packages (or any reasonably-sized graphics) into Comic

Strip Factory parts.

Part Maker's operation is simple. Part Maker builds a parts file
in memory. The Part Maker window shows how many parts
are in memory and how much free memory remains. Initially,
of course, there are no parts in memory. To merge an existin
parts file with the one in memory, choose Merge Parts... an
select a parts file. To scan a MacPaint file for parts and add
the parts found to the parts in memory, choose Merge
Paint... and select a paint file. To save the parts file in
memory, choose Save Parts... and enter a file name. To erase
the parts in memory and start with a clean slate, select New.
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HIYA! AS THE MosT
COMPLEX AND
ANATOMICALLY
CORRECT £ICURE 1N
THE COMIC STRID
FACTORY AT THE

1 MOMENT, THE cliys

A THOUGHT 1T WOuLD Ee
NEAT IF | EXPLAINED 4 ¢
FEW THINGS ABQUT
PUTTING BODY

PARTS TQGETHER...

“Character Assembly”
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Moild Me Closer, Tawny Dancer

TAWNY DANCER
EXPLAINS IT ALL
FOR You!

BY ANDY,
TRIC!, AND
DAYID

ALSO, ! GOT TO DO
LOTS OF SiLLY
STUFF, LIKE THIS...

o

(| THOUGHT IT SOUNDED KINDA
YUCKY \WHEN THEY PUT IT
THAT WAY, BUT THEN THEY
SAID | COULD USE MY OWN
BODY TO SHOW YOU HOW, [ ed:
AND | SAID "NEATY | THINK A [/
PERSON SHOULD TAKE EVERY |7
OPPORTUNITY TO USE THE
GIETS THEY'RE BORN WITH 70
PERSONALLY EDUCATE
QTHERS, DON'T YOUu?

HERE'S ME \IITH TWa
RIGHT FEET. ! Slipe
COULDN'T DO MUCH

DANCING LIKE THIS!
THAT'S WHY | Al\AYS
MAKE SURE BOTH BIG

TOES ARE TOWARD THE

CENTER OF MY BADY.
UNLESS I'VE COT MY

LEGS CROSSED,
NATCH!

VTR
POP QUIZ:

IS THIS HER LEFT FOOT
QR HER RIGHT FQQT?

¢ ene \Je SEE MY INNER THIGH. SEE HOW [
i THe 'V STRIPE POINTS TO THE KNEE? | [
SSESES KW THESE WOULD COME IN HANDY!

i1 COMPARE IT TO MY OUTER THIGH. (OH
GAWD, | SWEAR | AM SUCH A TUB?)
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'ARMS ARE GREAT.TJUST SO YOU KNOW, THOHCﬂ
DONTCHA LOVE THE BACKS OF MY HANDS
'EM? THE RADIUS [ HAVE "¥" SHAPES QN €Ml MY
BONES CAN TWIST | PALMS ARE BLACK!
ARQUND EACH P
QTHER SO THE  F
PALMS OF YOUR F&
HANDS CAN BE il
FACING FRONT
OR BACK, NO
MATTER WHICH
WAY YOUR FACE
IS FACING.

ATTACH MY LEGS SO
THAT THE TOP EDGES
MEET. THINK OF A
¥’ HECK SWEATER.




| ON THE QUTSIDE, THEY
| POINT WP, TOWARD MY
1‘SHO(«!LDER!

N THE INSIDE OF MY
UPPER ARMS, THE 'V

STRIPES POINT DOWN,
TOWARD MY ELBOW.

s

FOR THE TWISTY
STUFF, USE YOUR
| OWN ARM AND
| HAND AS A MODEL!

YT
WHEN YOU'RE STICKING MY
ARMS ON MY BADY, THEY
SHQULD JOIN RIGHT AT MY
SHOULDERS. If THERES A
STRAY PIXEL OR TWO
AFTERWARDS, JUST SMOQTH
IT QUT WITH EDITBITS!

THUMBS ARE LIKE BIG
TOES (REMEMBER?): PALM E
UP, THUMS OUTSIDE; PALM |

DOWN, THUMB INSIDE! |

T

N

WANKHA HELP ME GET MY HEAD
TOGETHER? JUST STICK THE
BATTOM OF MY MECK ON MY BODY!?

ON FORESHORTENED OR TILTED BODIES OR
HEADS, LINE UP THE CENTER=POINT OF MY
NECK STRIPE WITH THE CENTER POINT OF MY
CLAVICLE STRIPE. If EITHER OF THEM DOESN'T
SHOW, JUST QVERLAP MY NECK STRIPE WITH
MY BODY STRIPE! (TICKLES!)

: ALL TOGETHER NQW.
A START WITH MY TORSQ.
|| NOW ADD MY HEAD..

Py “Q

~THEN MY ARMS AND
LEGS DONT TRY TO
JOIN UP MY LEGS FIRST! |5

OKAY, NOW YOu TRY IT.
HOW DO | LOOK? KINDA
3 WEIRD! CHECK A MIRROR
| AWD SEE If YOU CAN

¢ TAKE THE SAME

7| POSITION! NO? THEN !
BETTER TELL YOU ABQUT:
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| LIAN
THE BUG TAOK ME TO AN iTA
] RESTARRAHT QNCE AND | PIGGED

ouUT ON THIS STUFE. Ha-HA!

WHAT IT REALLY MEANS
IS "HOW TO STAND LIKE A
GREEK STATUE" OR

<6§?
SOMETRHING.WITH ALL
THE ANGLES Of THE
80DY OPPASITE ALL THE
QTHER ANGLES!

“\

SHOULDER SLANT IS
ALWAYS QPPQSITE THE HIP
SLANT. If YOU DON'T
BELIEVE ME, STAND WITH

IT'S THE RIGHT WAY 70
STAND, ANYWAY. THE

=il

FULL-LENGTH MIRROR!
\, _

: YOUR WEIGHT ON ONE
LEG AND LOOK IN A

S

NOW TRY TQ
SLANT YOUR
SHOULDERS
THE SAME

WAY AS YOUR

HIP. ICKQ!

€

i

WEIGHT. THE FOQT
ATTACHED TQ THE
LEG ATTACHED 70
THAT HIP SHOQULD
8€ UNDER THE
CROTCH!

‘
@ THE HIGH RIP
’\ SUPPQORTS THE

OFF
BALANCE!

YOuU SHOULD HAVE AS
MANY TORSOS AS YOU
NEED FOR THIS 8UT
YOu CAN HELP BY
ASSEMBLING ONE ARM
SLIGHTLY HIGHER THAN
THE OTHER. THAT S WHY
MY SHOULDERS ARE

BUILT INTQ MY ARMS!
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TALKING ABOUT MY CELLULITE, BUSTER.

NONE OF US HERE N C.S.F. WOULD THINK

OF TRYING TQ GET ALONG WITHOUT THESE
LITTLE PIXEL PALS.

THEY'RE ACTUALLY
CALLED EDITBITS IN
THIS PROGRAM. ON THE
NEXT PAGE, MY LITTLE
BUDDY THE NERD WiILL
SHOW YOU WHAT You
CAN DO WITH THEM!
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HI! we BlLL C.S.F. AS A
GRAPHICS PROGRAM
YOU DON'T NEED TO BE
AN ARTIST TO USE.
HEVERTHELESS, THERE
ARE SOME SIMPLE
THINGS YOU CAN DO IN
EDITBITS THAT CAN
EXTEND THE ARTWORK
WE'VE SUPPLIED!

JUST BY MAVING
THE PUPILS OF
THE EYES AND
ERASING PART OF
THE CHEEK LINE,
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SUBTLE CHANGE
OF EXPRESSION!
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SOME MORE, AND YOU CAN ; 4 PROCGRAMMER, NOT
EVEN GET A NIFTY 3 2, 8Y AN ARTIST, SO

EXPRESSION OF DISTASTE! DON'T BE AFRALID
70 TRY 7!




Introduction

Comic Strip Factory provides all the tools you need to create
comic strips. The comic strip can be created using artwork
supplied with Comic Strip Factory or graphics created in
MacPaint and compatible graphics programs. Like MacPaint,
Comic Strip Factory create single-page documents. Multiple
page comic strips require multiple comic files. (Future
versions of Comic Strip Factory may support multiple-page

files.)

Generally speaking, Comic Strip Factory is an object-oriented
graphics package (like MacDraw) designed for manipulating
bit-mapped images (like those created in MacPaint). Its
special tools and data types, detailed below, optimize it for
making comics.

Objects and Panels

Comic Strip Factory uses a few simple kinds of graphic
objects which are placed in, and in front of, panels.

Panels are shapes where objects and backgrounds usually
appear. Panel arrangement defines the structure and flow of
the comic strip. When a comic page is first created, it
contains rectangular panels, all the same size. Existing panels
can be customized by adding resizeable rectangles, ovals, and
triangles to panels. And new panels can be created from these

Character Assembly @



three editable shapes. An area of the page may be covered by
a panel or be empty, but it can't be covered by more than one
panel. Since panels don't overlap, when you add a shape to
one panel, you usually also subtract part of that shape from one
or more neighboring panels.

Each panel may be given a background picture and a
background pattern.

There are four types of objects. The first are parts. Parts are
small pictures that are usually pieces of comic
characters—heads, bodies, arms, legs, hands, feet, and so
on—that can be put together in combinations to populate a
comic strip. Parts are supplied with Comic Strip Factory in
parts files.

We'll be selling additional parts disks with more comic
characters in the future. (We may be already, in fact! Send in
your registration card, and we’ll let you know about new
offerings by flooding you with junk maill) There are also tools
to create new parts files from MacPaint artwork. A tool like
MacPaint's FatBits (we call it EditBits) allows you to customize

parts.

The second object type is the text object. Text objects
include seven different kinds of dialog and thought balloons,
and narrative boxes. Text in balloons can vary by font, style,
and size. Text objects are created with a balloon editor that
has editing features similar to MacWrite’'s. Text can be typed
in the balloon editor or taken from Macintosh text-only files
created by MacWrite, Microsoft Word, and other word
processors. Once a balloon is created, pointers can be added
to indicate the speaker or speakers. The balloon shape can be
customized in EditBits.

The third object type is the silhouette. Silhouettes are
shadows of other objects. They are unique to Comic Strip
Factory; they can't be loaded or pasted in from anywhere else.
Silhouettes are created black, but can be changed to a pattern,
and they can be painted over the background and objects they
cover; or they can be semitransparent, lightening or darkening
the background. The silhouette shape can be edited in Comic
Strip Factory’s by-now famous EditBits.
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The final object type is the group. A group is a collection of
objects of any type or types, including other groups. Group is
a convenience feature: once you've assembled parts,
silhouettes, and text balloons, you can group them. Grouping
makes many objects behave as a single object, making it easier
to move and copy the group intact.

Grouping isn't permanent: To change the head on a character
that you've grouped, for example, you can easily ungroup the
character, delete the old head, put in the new one, and group
it again.

The Icon Bar

Comic Strip Factory includes another convenience: the Icon
Bar.

Under the menu bar is a white strip containing fourteen icons.
The icons duplicate frequently used menu commands. Since
Comic Strip Factory is primarily a mouse-driven program, the
icons provide a fast and easy mouse shortcut to menu
commands. Some menu commands also have command key
equivalents, especially those common to other programs.
When a command is unavailable, both its menu item and its
icon dim.

There is also space on the right-hand side of the icon bar for
two buttons, OK and Cancel. These buttons are used to exit
some of the program's special modes, such as the balloon
editor, the bit editor, and Show Page. The buttons appear
when the program is in one of those modes.

Windows

There are four types of Comic Strip Factory windows. The
first and most important is the comic window. This is

where a comic document is edited. A comic window is opened
by selecting New Comic Strip or Open Comic Strip from
the File menu.

Second is the background window. This holds the
background picture associated with the currently opened
comic file. A background picture is loaded from a MacPaint
file with the Install Background command in the File menu.

Windows




The background window treats a MacPaint file in one of three
ways: 8" by 10" Portrait (the normal MacPaint orientation),

16" by 5" Wide Screen, or 24" by 3 1/3" Panorama.

Install Background creates Wide Screens and Panoramas by
dividing the portrait into two or three horizontal strips, then
reassembling them next to each other. Several background
pictures are provided with Comic Strip Factory. Once
installed, the background picture can be changed or blanked
out with the Change Background item in the File menu,
which replaces Install Background when a background is

installed.

The third window is the text window. This is a basic text
editor that can be used to write comic strip scripts. Scripts
can also be written in MacWrite, Microsoft Word and other
programs that save text-only files. Text in the text window can
be selected with the mouse and brought into the balloon editor
to be transformed into text objects.

The text window is opened with the New Text and Open
Text commands in the File menu.

The fourth window is the parts window. The parts window
is where parts files supplied with Comic Strip Factory are
loaded, and where new parts files are created. Parts can be
created by pasting graphics into this window from MacPaint.
They can be moved into the comic window using the usual
Edit menu features, or using a special, faster copy feature of

Comic Strip Factory.

The parts window is opened with the New Parts and Open
Parts commands in the File menu.

Windows, Keys, and Mouse Actions

All four windows behave normally. Clicking on a window
behind another window brings the rear window to the front.
Dragging the title bar moves the window; dragging the grow
box (in the lower right corner) resizes the window. Scroll bars
scroll in expected ways (refer to your Macintosh user's manual
if you're not familiar with the Macintosh user interface.)
;;\vai%ability of many commands depends on which window is in
ront.
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The availability of and the actions performed by certain menu
items depends on what object or objects are selected. Most
menu actions are performed on selected objects.

Clicking on an area where there is no object and dragging
stretches a selection rectangle. When the mouse it released,
any objects inside or overlapping this rectangle are selected.
If the Shift key is held down, the new selections will be added

to objects already selected.

Clicking on a selected object and dragging moves that object
and other selected objects when the mouse is released. Any
restricted objects moved outside their panel will be dropped
into another panel, unless they don't overlap any panel, in
which case they are freed from panel boundaries. The last
object clicked is the key object; it always remains selected
after the drag. Any restricted objects that end up in a different
panel from the key object are deselected.

Holding down the Option key while clicking on and dragging
objects leaves a copy of the object in the object’s original
location.

Holding down the Command key while clicking on and
dragging objects restricts movement to the vertical or
horizontal axis, depending on which direction the mouse is
first moved.

Pressing the Backspace key deletes all selected objects.

The Background Window

contains the background picture, which is actually stored as
part of the comic document. When the background window is
brought to the front, it displays an animated outline
representing the current panel in the comic window. The
location of this outline (along with settings in the

Background Pattern dialog) determines the back
picture displayed in the panel. ground

The background picture of the selected panel may be ch

an
by dragging the animated panel shape to another}iocation o%ed
the background picture. If the distance you want to move the
shape is larger than the window, you can scroll to the desired

destination and click the mouse to * »
siineercs snap” the shape to the
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The part of the background picture surrounded by the
animated shape is copied to the panel by choosing the Copy
to Panel command in the Panel menu. This also brings the
comic window to the front. Any other method of bringing
another window to the front leaves the background of the
panel as it was before.

The Text Window
contains a text-only document which may have been created in
Comic Strip Factory or a word processor or text editor. In the

text, it displays either a selected range of inverted text or a
blinking insertion point.

=== Hard Return script &=
FIRST PANEL G

SETTING:

B8, 15 SINGING ON THE STAGE OF THE
ORPHEUM THEATER. THE AUDIENCE,
SEEN FROM THE REAR, IS A SEA OF BE.
TOP HATS.

<3 WATIN ON DA LEVEE.WATIN ON
DA LEVEE. £Q DA ROBERT £ LEEN

AUDIENCE: "KLEP, KLEP, KLEP, KLER.”
INSET:

CLOSE-UP OF AN UNSHAVEN 88
THOUGHT BALLOON:

CYEAH, THAT WAS ME. | WUZ INNA BIG
TIME_THEY DIDWT CET NQ BIGGER THAN |D]

The Text Window




Clicking the mouse in the text places an insertion point;
clicking and dragging selects a range of text. Typing while a
selection is displayed deletes the selected text and replaces
the selection with an insertion point. Typing while there is an
insertion point inserts the characters typed at the insertion
point.

Cut, Copy. and Paste in the Edit menu perform the same
actions on selected text as they do in other text edit programs.
Cut deletes the selection, leaving a copy on the clipboard.
Copy puts a copy of the selection on the clipboard. Paste
replaces the selected range of text with the contents of the
clipboard or inserts the contents of the clipboard at the

insertion point.

The selected text can be copied into the balloon editor by
selecting Copy to Panel from the Panel menu. Once there,
- the text can be made into a balloon and placed in the comic

window.

The Parts Window

contains a parts document from which parts may be copied to
the comic document. A parts document is a library of parts; it
usually contains a set of parts that are used to create a single
character. Some parts files may contain props (things) or body
parts that may be used by more than one character. Actually,
since you can create your own parts files, parts windows can
contain whatever assortment of parts you want.

Nerd Parts
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Selecting objects in the parts window works like selecting
icons in the Finder. It has fewer restrictions than selecting
and manipulating parts in the comic window because the parts
window contains no panels. Still, only thirty-two objects may
be selected at once. An object is shown to be selected by an
animated rectangle around it.

Clicking on an object selects it. If the Shift key is held down,
it leaves previously selected objects selected; otherwise, it
deselects them. Clicking on a point where there is no object,
without holding the Shift key down, deselects all objects.
Shift-clicking on a selected object deselects that object
without deselecting other selected objects.

Clicking on an area where there is no object and dragging
stretches a selection rectangle. When the mouse is released,
any objects inside of or overlapping this rectangle will be
selected. If the Shift key is held down, they will be added to
the objects currently selected.

The availability of and actions performed by certain menu
items depends on what object or objects are selected. Most
menu actions are performed on the selected objects.

Hitting the Backspace key deletes all selected objects.

Clicking on a selected object and dragging moves that and all
other selected objects when the mouse is released. Holding
down the Option key while clicking on and dragging objects
leaves a copy of the objects behind.

Holding down the Command key while clicking on and
dragging objects restricts the movement to the vertical or
horizontal axis, depending on which direction the mouse is

first moved.

Selected parts may be copied to the selected panel of the
comic window, bypassing the Edit menu, by selecting Copy to
Panel from the Panel menu.

The Parts Window .I



Menu and Icon Commands

Apple menu

Comic Strip Factory has a standard Apple menu. The first item
is About Comic Strip Factory..., where program credits are
shown. The remainder of the menu contains the desk
accessories installed in your system.

File menu

New Comic Strip

creates a new comic document. It is available only when no
comic document is open. It brings up a dialog that allows you
to establish the initial layout of the page.

Set initial layout
for this document:

A 02
s s
b vy

01 @203 014
®Tall O Wide

( cancel | [ 0K ]

You can set up an initial layout that consists of up to four rows
of panels and up to four panels in each row. The panels will be
rectangles of equal size and shape. The layout is reflected in a
diagram in the middle of the dialog.

The Tall and Wide radio buttons select page orien

sets of four radio buttons, to the right ofpargd belowtathtign' g
diagram, select the number of rows and number of panels per
row. The stretch handles on the page rectangle allow the area
of the page that will be filled with panels to be changed. All
changes to the default layout will be shown in the diagram
Clicking OK creates a new document laid out as shown. -
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two other ways. One way is to
ee horizontal strips then

three times as wide as the
1; we call this Panorama.

A background can be drawn in
divide a MacPaint picture into thr
display the strips as a single strip,
MacPaint file, but only a third as tal

The other divides the Paint file into two horizontgl strips and
reconnects them twice as wide as the MacPaint file, but only
half as tall: this is called Wide Screen.

Once a background is installed and interpreted in one of these
three ways, any panel in the comic that is not larger than the
background picture in either dimension can have part of the
background picture copied into it as background.

Also on the background dimensions dialog are three buttons.
Change Picture brings up the standard open dialog and
allows you to select another MacPaint file as the background.
Blank allows you to return to the original state of having no
background picture associated with the file. It closes the
background window and exits the dialog. OK accepts settings
you've made and exits the dialog. Any changes made will aﬁ%ct
backgrounds in all panels that show background pictures.

Change Background...

is available when a comic that already has a background
associated with it is open. It brings up the background
dimensions dialog, where you can change the dimensions of
the background or replace the background picture with
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another (see Install Background...). Any changes made will
affect backgrounds in all panels that show background

pictures.

Open Text...
brings up the standard Open dialog and allows you to open a

text-only file in the text window. It is available only when no
text file is open.

Open Parts...
brings up the standard Open dialog and allows you to open a

parts file in the parts window. It is available only when no
parts file is open.

Close
If the comic window, the text window, or the parts

window is in front, Close closes the window. If there have
been changes to the file since it was opened or last saved,
you're first asked if you want to save your changes. If a desk
accessory is frontmost, the Close command closes the desk
accessory. The desk accessory may then ask if you want to
save data. Since the background is part of the comic file, if the
background window is in front, the Close menu item is
disabled. The background window may be closed without
closing the comic window by clicking the Blank button on the
background dimensions dialog, accessible through the Change
Background... and Install Background... commands. See

Install Background....

Save
If the comic window, the text window, or the parts

window is frontmost, the Save command saves the document
in the window. If the file has never been saved (when the
window is titled “Untitled”), the program will ask you for a file
name through the standard Save As dialog. See Save As....
Since the background is part of the comic file, if the
background window is in front, this menu item is disabled.

Save As...
If the text window or the parts window is in front, this

command brings up the standard Save As dialog and allows you
to name and save the document in that window.

If the comic window is in front, the Save As dialog includes
two radio buttons that allow you to choose between saving the
comic as a comic file or as a MacPaint readable file. Wide
documents will be rotated to fit in MacPaint format. Since
Comic Strip Factory can't load MacPaint files as comic files, it
does not consider that the document has been saved if it has

File menu










how Page...
isi"tge con%ic window is in front, displays a miniature version

isplayed is
lavout of the comic document. The comic disp
gifmu;fiﬁggl’: l':lll objects are shown as black outlines axi;)ugdfwrﬁte
shapes, and panels with any other background but the ebalild 3
white are shown in light gray. The selected panel has a bolde

outline than the other panels.

A new panel may be selected in show page mode by clicking in
it. Clicking outside of the panel boundaries places a small
crosshair on the miniature page at that point. If the last click
on the miniature page was inside a panel, clicking the OK
button in the icon bar scolls the document to that panel. If the
last click was outside all of the panel boundaries, clicking OK
scrolls the document to that point. Clicking the Cancel
button on the icon bar closes the miniature page without
changing the selected panel or scrolling the document.

Panel menu

Add l}ecltan le o

is available when the comic window is in front. It cr
animated, stretchable rectangle the same size and locaet?ctgs aasn
the selected panel and places you in panel reshaping mode
The OK and Cancel buttons on the icon bar are enabled. In
this mode, you can scroll the document or select a different
panel. You cannot select or move objects, issue other
commands, or bring other windows fo the front. The purpose
of this mode is to reshape a panel by adding the animated
shape to it or to create a new panel from the animated shape
You can exit this mode without changing the panel layout b ‘
clicking the Cancel button on the icon bar. Y
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[7] Use pattern: @ as background
() to darken background
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The dialog has a check box and three radio buttons. Using
these controls, you can set up one of four situations.

« If the Use pattern checkbox is unchecked, the three
radio buttons are dimmed; their settings are
remembered, but ignored. The panel will display the
background picture without any pattern modification.

e If the Use Pattern box is checked and the as
background radio button is on, only the selected pattern
is used as the background; no picture is displayed.

e If the Use Pattern box is checked and the to darken
background button is on, the selected pattern is washed
over the picture like a watercolor. White parts of the
Bicture are darkened (replaced with the pattern) and

lack parts are left alone.

« If the Use Pattern box is checked and the to lighten
background button is on, the selected pattern is
subtracted from the picture, producing an “overexposed
Fhotogra h" effect. Black parts of the picture are
li htelne (replaced with the pattern) and white parts are
elt alone.

If the parts window is in front, Use Pattern brings up the
same dialog without the check box or radio buttons. This is
used simply to select a background pattern for the parts
window. e menu item is unavailagle for other windows.

Copy to Panel
is available in the background, parts, and text windows, but
not in the comic window.

In the parts window, it copies the selected part or parts into

the current panel and brings the comic window to the front,
scrolling to the selected panel if necessary.

Panel menu @
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Characters typed at the keyboard are inserted in the text area.
Clicking the mouse in the text area places the cursor for text
insertion. Clicking and drag%ing over text selects that text.
Double clicking on a word selects the word. Double clicking
and dragging selects a range of words.

Clicking on the scroll bar scrolls the text up or down. Clicking
on the icon at the bottom of the scroll bar and dragging it left
or right resets the width of the text area. The width of the
text area controls the width of automatic word wrapping. Text
can be wrapped manually by inserting returns.

The Cut, Copy, and Paste buttons duplicate commands on the
edit menu. Cut copies the selected text into the clipboard and
deletes it from the text area. Copy copies the selected text to
the clipboard. Paste inserts the text in the clipboard at the
insertion point, or if text is selected replaces the selected
text with the contents of the clipboard. Cut, Copy, and Paste
have keyboard equivalents of Command-X, Command-C, and
Command-V, respectively.

In the center of the control area is a scrolling list of fonts
available from the current system. Clicking on a font name
and clicking the Set Font gutton, or double clicking on the
font name, changes the selected text to that font. no text is
selected, it sets the font for subsequent text entered at the

insertion point.

Objects menu



ns for setting the
quently entered
t point sizes; the

On the right side of the control area are butto
style and size of selected text or of text subse
at the insertion point. The number buttons se
lower six buttons set styles. Style buttons have ke board
alternatives consisting of the Command ke and the first letter
of the style name: Command-B sets Bold, for example.

Three rows of icons in the lower left corner of the control area
set text alignment and set the appearance of the balloon. The
top right set of three icons set text flush left, centered, and
flush right. These changes are reflected immediately by the
text displayed in the text area. The top left set of icons
control the thickness of the line used to draw the balloon:
from left to right, the settings are no line, one pixel thick, and
two pixels thick. The bottom row of icons controls the type of
balloon created. The balloon is not created until you click OK,
so changes made by clicking on these icons aren't apparent

until then.

Add Text...
is available in place of Edit Text... when the comic window

is in front and nothing is selected. It brings up the balloon
editor with an empty text area and allows you to create a
balloon from scratch. See Edit Text....

Edit Bits...
is available from the comic window and the parts window

when one part, text item, or silhouette is selected. It cannot
be used with multiple objects or groups. The commands
brings up the Bit Editor screen and lets you edit the selected
part in a FatBits-like manner. In the bit editor, all menus are
disabled; available controls are the mouse, the tools and other
icons on the left, and the OK and Cancel buttons on the icon
bar, which are used to exit the mode.

Comic Strip Factory User Manual
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There are actually two bitmaps, superimposed on each other,
that can be edited in the Bit Editor. One, represented by black
squares, is the picture of the object. The other, represented
by white squares, is the background mask: the white part of
the object through which the background can't show. Think of
the white bits as a paper cutout where black bits are drawn.
The gray area is the background: it doesn't represent part of
the object. The general rule is that black bits may only be
drawn on white, not on gray, and white bits may only be drawn
on gray, not on black (because there is already white under the
black). You also can't erase the white underneath black bits
unless you first erase the black.

Which bitmap you are drawing on or erasing from is
determined by the two radio buttons on the left. Selecting the
one with an icon showing black bits against a background of
white bits allows drawing or erasing black bits. The one
showing white bits against a gray background allows the
editing of white bits.

These options are only available when you are editing a part.
When editing text items and silhouettes, you can only edit
white bits, and the black bits radio button doesn’t appear.

The four tools are selected by the icons on the left, above the
radio buttons. The tools are similar to tools with the same

icons in MacPaint and other programs. The hand tool allows
the object to be scrolled. Holding down the Option key while

Objects menu ‘l
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any of the other tools are active brings up the hand too
terylporarﬂy. Double clicking on the hand icon centers the
object. Holding down the Command key while dragginghcauses
the scrolling to be restricted to the first axis along which you

move the mouse.

The pencil icon is a pencil that acts on the selected bitmap
(see gbove). If you click first on a bit that is off and drag. it acts
as a one pixel wide pencil. If you click first on a bit that is on
and drag, it acts as a one pixel wide eraser.

The bottom two icons are each a “hard wired” brush and
eraser. They paint or erase the selected bitmap in swaths as

wide as their cursors.

"5 Create Part...
\& is available when the comic window or parts window is in

front and nothing is selected. It replaces Edit Bits... in the
menu. It brings up the Bit Editor with no object drawn in it
and allows you to create a part from scratch. See Edit Bits....

S Duplicate
Q@ is available in the comic window or the parts window when

one or more objects of any type are selected. It makes copies
of the selected objects, placing them below and to the right of
the originals.

Invert
is available in the comic window or the parts window when

one or more ot(:f)ects of any t)}Pe are selected. It inverts the
objects selected. It has no eflect on silhouettes.

P Flip Horizontal

— is available in the comic window or the parts window when
one or more parts, silhouettes, or groups that don't contain
text items are selected. Text items and ﬁroups containing text
items cannot be flipped. The command flips each object
around its own vertical axis, swapping left for right.

Flip Vertical
; is available in the comic window or the parts window when
one or more parts, silhouettes, or groups that don't contain
text items are selected. Text items and groups containing text
items cannot be flipped. The command ﬁips each object
around its own horizontal axis, swapping top for bottom.
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@ go::z:l?able in the comic window or the parts window when
one or more parts, silhouettes, or groups that don't contain
text items are selected. Text items and groups containing text
items cannot be rotated. The command rotates each object
ninety degrees counter clockwise around its own center point.

Point Balloon
is available in the comic window when one text item is

selected. It enters pointer adding mode, which is used to add
a pointer to that balloon.

D R eeessas Untitled B
—p———

Hey! You aren't
supposed to be

In this mode, when the mouse cursor is in the window and not
over the balloon, the cursor chan%es to a picture of a balloon
with a pointer on it. A stretchable pointer from the center of
the balloon comes to a point at the cursor's pointer. If you
click the mouse button when the cursor looks like a balloon
and the pointer is visible, the pointer is added to the balloon.
If the cursor is arrow shaped when the mouse is clicked, the
mode is exited without adding a pointer to the balloon.

More than one pointer can be added to a given balloon. To
revert the balloon to its original state, select it, choose Edit
Text from the Objects menu, and click OK.

Make Silhouette

is available in the comic window when any object or objects
are selected. The command duplicates the shape of the
obiects in black silhouette form, offsetting the silhouette
below, to the right of, and underneath the original object.
Silhouettes are good for making shadows or for lightening or
darkening a portion of the picture for some other purpose.

Set Pattern...

is available in the comic window when one or more
silhouettes are selected. It brings up a pattern dialog similar
to the one used for background patterns.

Objects menu @
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You can select a pattern for the silhouettes selected by clicking
on the pattern; it will be displayed in the box on the left.

Three radio buttons allow you to determine how the pattern is
drawn. If you select covers background, the silhouette will
be opaque. The darkens background and lightens
background buttons cause the silhouette to be translucent;
whatever is under the silhouette will show through, but it will
be lightened or darkened by the pattern selected. Note that it
is possible to make silhouettes invisible and lose them by
having them lighten an already white background (or darken a

black one).

MergeBits
is available in the comic window and the parts window

when one or more objects are selected. If only one object is
selected, it must be a group, text object, or silhouette. The
command merges the selected objects into a single part.

This is superficially similar to the Group command in the
Arrange menu. The difference is that Group remembers
each object separately and allows them to be ungrouped later.
MergeBits makes them all into a single bitmapped object; it
cannot be undone. Group makes it easy to treat an assembled
character as a single object while still having the freedom of
ungrouping them and exchanging a head or a hand.
MergeBits creates objects that can be edited with Edit
Bits... and flipped or rotated even if they contain text,
although text objects made into parts with MergeBits can no
longer be edited as text.
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Groups always take up slightly more memory than the
component parts, while several objects made into a single part
with MergeBits usually take up less memory than the original
set of objects. The exceptions to this rule are when a single
text object or a single silhouette is merged, as text objects and
silhouettes use less memory than equivalent bitmapped parts,
and when two or more parts that don’t overlap are merged.
Finally, merged parts are always drawn faster than equivalent
roups. A text object merged into a part is always drawn
Zster, and two parts that are merged are usually drawn faster.

Arrange menu

Bring to Front
is available in the comic window and the parts window

when any object or objects are selected. It brings objects that
are restricted to a panel up in front of all other objects in that
anel, but not in front of freed objects, and objects that are
reed from panel boundaries in front of other freed and
restricted objects. (See Free from Panel.) Since there are
no panels in the parts window, it just brings objects in the
parts window to the front of all other objects.

If the Option key is held down while this command is issued,
restricted objects will be freed from their panels and brought
to the front of freed objects as well as restricted objects.

Send to Back
is available in the comic window and the parts window

when any object or objects are selected. It sends objects that
are restricted to a panel behind all other objects in that panel
and obiects that are freed from panel boundaries behind other
freed objects, but not behind restricted objects. (See

Restrict to Panel) Since there are no panels in the parts
window, it just sends objects in the parts window behind all
other objects.

If the Option key is held down while this command is issued,
freed objects will be restricted to panels and send behind
other restricted objects as well as freed objects.

Group

is available in the comic window if more than one object is
selected. It makes the selected objects into a single group
object. If the group is selected or moved, all the objects in it
are selected or moved. Anything done to the group is done to
all members of the group. All objects in a group that is rotated
or flipped are rotated or flipped around a common center.
Groups that contain text objects cannot be rotated or flipped.

Arrange menu
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Windows menu

Comic Strip
is available whenever the comic window is open. It brings
that window in front of all other windows.

Background .
is available whenever the background window is open. It
brings that window in front of all other windows.

Text
is available whenever the text window is open. It brings that
window in front of all other windows.

Parts
is available whenever the parts window is open. It brings that
window in front of all other windows.

Keyboard Shortcuts & Extensions

Comic window:
Tab scrolls to the selected panel.

Arrange menu:

Option-Bring to Front causes objects to be freed and
brought to the front of other freed objects.

Shift-Bring to Front causes objects to be moved one step
forward.

Option-Send to Back causes objects to be restricted to
the current panel (if they overlap it) and sent behind
other objects in the panel.

Shift-Send to Back causes objects to be moved one step
backward.

Selecting and moving objects:
Shift selects new object without deselecting.
Option duplicates the objects being moved.
Command restricts movement to one axis.
Arrows or Command-I, J, K, and M move object one pixel.

Panel reshaping mode:
Shift-clicking OK causes the program to remain in panel
reshaping mode.
Command-clicking OK forces a new panel to be created
with background consistent with current panel.

Keyboard Shortcuts & Extensions @
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round: A MacPaint file loaded into a comic strip file
?Q‘;’; e interpreted as a 'I?anorqma (a 24" wide by 3 1 3"111(511 ®
strip) a Wide Screen (16" by 5") or a Portrait (8" by 10").
panels that are not lar%er than the background type chosen
may have portions of the background picture copied into

them.

Balloon: A shape containing text for either narrative or dialog,
Also a text object.

cancel: A button on the icon bar (with OK) used to exit
special editing modes without accepting any changes to the
thing being edited.

Character: An actor in a comic strip, built up of parts.

Comic: A graphic document built up of panels, backgrounds,
characters, and balloons. Occasionally humorous.

Group: An object in a comic that is a collections of parts, text
objects, silhouettes, and other groups. It may be moved
around as a single object, or ungrouped to get at the individual
objects that make it up.

Icon Bar: The strip under the menu bar containin§ fourteen
icons, duplicating the features of the most frequently used
commands in the program’s menus, and two buttons used in
special editing modes.

Object: Any thing that can be moved around in a comic strip.
There are four different kinds: parts, text objects, silhouettes,
and groups, each with special characteristics and capabilities.

OK: A button on the icon bar (with Cancel) used to exit

special editing modes and incorporate changes to the thing
being edited.

Panel: A structural element in a comic strip. A shape used to
contain background and characters.

Part: A bitmapped object. May be a head, body, arm, hand,

foot, leg, or miscellaneous segment or personal prop of a
comic character. € ¥ &

Glossary







Appendix A

Recommended Reading

The following list is a sampling of work currently available by
some of the best comic practitioners of the last forty years.
They can show you how it's done. (They've showed other
comic creators for years.) All titles are available at comic
specialty stores or directly from the publishers.

Periodicals

Weirdo, P. Bagge and R. Crumb, eds. Last Gasp Eco-Funnies,
P.O. Box 212, Berekeley, CA 94701. Single copy price $2.50.

Steve Canyon Magazine, by Milton Caniff. Kitchen Sink Press,
2 Swamp Road, Princeton WI 54968. Single copy price $3.50.

The Fabulous Furry Freak Brothers, by Gilbert Shelton. Rip Off
Press. P.O. Box 14158, San Francisco, CA 94114. Single copy

price $1.50.

Kurtzman Komix, by Harvey Kurtzman. Kitchen Sink Press, 2
Swamp Road, Princeton, WI 54968. $1.50.

Love and Rockets, by Los Bros Hernandez. Fantagraphics
Books, 4359 Cornell Road, Agoura, CA 91301. Single copy

price $2.25.

Books

“The Carl Barks Library of Walt Disney's Donald Duck.”
Another Rainbow Publishing, Inc., Box 2206, Scottsdale, AZ
85252. Ten boxed sets, sometimes available in single volumes.

“Frontline Combat.” Russ Cochran, Publisher, P.O. Box 469,
West Plains, MO 65775. 3-volume boxed set, $70.

“The Smithsonian Collection of Newspaper Comics.”

Blackbeard and Williams, eds. Smithsonian Institution Press,
Washington, DC 20560. $25.

Recommended Reading
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Add Oval 10-11, 48

Add Rectangle 10-11, 46

Add Text... 17, 52

Add Triangle 10, 48

Apple menu 40

Arrange menu 57-59
shortcuts 59

As background 49

Background 12-15
cover 56
darken 15-16, 49, 56
dimensions 12-14, 41-42
eliminate 14, 16
installing 12
lighten 15-16, 49, 56
mask 20-21, 53
panorama 12-14
patterns 13-16
picture 36-37
portrait 12-14
wide screen 12-14
window 14, 33, 36-37, 42, 43-45
Background 59
Background Pattern 14-16, 23,
48-49
Background window 49-50, 59
Backspace key 36, 39
Balloon
editor 16-19, 32, 38, 50-52, 60
pointer 19-21, 55
type 52
Balloon pointing mode 55
Bit editor 52-54, 60
Blank 14, 42-43
Bring to Front 57
option key 57, 59
shift key 59
Broadway Bug 2-6

Index

Brush 54
Bubbles & Pointers 20
Bug, Broadway 2-6

C

Captions 16, 18

Case change 60

Centered 18, 52

Change Background... 14, 34,
41-43

Change Picture 14, 42

“Character Assembly” 25-30

Christie, Andy 61-62

Clear 45

Clipboard 22, 45

Close 43

Comic Strip 59

Comic window 33, 35-36, 38, 43-
46, 48-50, 52, 54-59

Command key 11, 36, 39, 51-52,
54, 59, 60

Contrapasto 26-27

Copy 17, 19, 38, 45, 51, 60

Copy to Panel 14, 19, 37-39

Create Part... 54

Cut 17, 38, 45, 51, 60

Dancer, Tawny 3, 6 25-27
Darken background 15-16, 49
Dialog 16-18

balloon 16
Duplicate 54
Durkee, David 61-62

2

Edit Bits... 20-23, 27-30, 32, 52-
54

Edit Text... 19, 50-52, 55

Edit menu 44-46

Eraser 20-21, 54
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Copyright

This is a fully copyrighted work, protected under the copyright
laws of the United States of America.

You may copy this software for your personal use only.
Duplication for any other purpose constitutes infringement of
copyright laws and is a crime.

The artwork included with The Comic Strip Factory is
copyrighted by the artists. You may publish this art in comic strips
created with The Comic Strip Factory without paying any additional
fees, as long as the following notice is included:

“Copyright ©1986. (Some of) the art in this comic is
copyrighted by Trici Venola and Kurt Wahlner.”

Limited Warranty

This program is provided “as is” without warranty of any kind.
You assume the entire risk as to the results and performance of the
program. If the program is defective, you assume the cost of all repair
or correction.

Also, Foundation Publishing does not warrant, guarantee or
make any representations regarding the use of, or the results of the use
of, the program in terms of correctness, accuracy, reliability, or
otherwise, and you rely on the program and results at your own risk.

Foundation Publishing does warrant that the program disk(s)
are free from defects in materials and workmanship under normal use
for a period of ninety (90) days from delivery as evidenced by your
receipt.

Foundation Publishing’s entire liability and your exclusive
remedy is replacement of the disk(s) not meeting Foundation
Publishing’s limited warranty. Defective disks should be returned to
Foundation Publishing with a copy of your receipt.

Updates

To obtain updates to this product, you must complete and return
the enclosed Registration Card to Foundation Publishing.

FOUNDATION cieciy e iy
PUBLISHING o







Copyright
This is a fully copyrighted work, protected under the copyright
laws of the United States of America.

You may copy this software for your personal use only.
Duplication for any other purpose constitutes infringement of
copyright laws and is a crime.

The artwork included with The Comic Strip Factory is
copyrighted by the artists. You may publish this art in comic strips

* created with The Comic Strip Factory without paying any additional
fees, as long as the following notice is included: '

“Copyright ©1986. (Some of) the art in this comic is
copyrighted by Trici Venola and Kurt Wahlner.”
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easy 1o assemble characters and move them ubout, make them
overlap panels and edit them in the fantastic two-layer Edit Bits
mode! Just watch as you move in the extra-wide backgrounds,
other fonts and stuff from MacPaint formatted clip-art packages,
then save the completed pages as MacPaint files and “shace” them
with the friends (tell them how easy it wasl

Thousands are becoming lucky comic authors-my way. With
“CSF" you simply utilize the dormant comic-power in your own

| Can Make YOU a Great Comic Artist in No Timel

|, most frequently used commands!

The Comic Strip Factory:

the tool for making comics!

= Nearly a megabyte of comic art and
fonts! Assembie characters easily from
predrawn parts! just click and copy!

* Includes PartMaker II: converts
MacPaint clip art files to comic parts!

* Rotate, flip, and invert! Group and
ungroup! Magnify and edit at the pixel
level!

o Custom panel shaping tools allow
diagonal and curved edges! Dialog
baljoons made to fit your text! Background
loaded quickly from any MacPaint file!

* Features Icon Bar for fast access to

* Lots more!

Runs on a Macintosk with 512K or more memory
100% hard disk compatible: got capy protected!

brain and watch it grow into humot, drppmng with gre: |
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Copyright © 1987 by Tricl Venola and Kurt Wahiner. The
contents of the data files on Comic People Volume One, disks 1 and 2
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Volume One manual are copyrighted by Foundation Publishing, Inc.
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Computer, Inc.
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Inc.
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Introducing Office Days

Comic People Volume One: Office Days is a collection
of characters, locations, and props designed to make it easy
to depict situations in the modern workplace. Its seven
characters are stored in Comic Strip Factory Parts files.

While they can't possibly represent every worker you
could possibly find in an office, they do represent a cross
section of management and labor, artists and
administrators, movers and shakers, mousers and
clickers, several popular ethnic groups, and the two
known sexes.

Even better, each character has a range of expressions
to fit any occasion. Examples include arrogant, bewildered,
choleric, determined, ecstatic, forgetful, grumpy, hapless,
incensed, joyous, knowing, laconic, mirthful, nihilistic,
oblivious, panicky, quixotic, resolute, sycophantic, tipsy,
unamused, violent, wasted, xerophilous, yammering, and
zealous. Their flexibility of expression combined with
their nearly infinite range of body positions makes them
adaptable to a huge variety of situations.

Also included is a file of background locations and a
file of props and furniture for those locations.

The backgrounds are locations in an office building.
You'll find that they're somewhat sparsely furnished. You
can fill in the details and customize them with art from
the props file. These files are stored in MacPaint format.
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Using Comic People...

...with The Comic Strip Factory

Comic People come in Comic Strip Factory Parts files,
Like the six original Comic Strip Factory characters, they
are broken down into heads, bodies, arms, hands, legs, and
feet. In some cases, some of these parts are preassembled.
In any case, the mechanics of using Parts files in The
Comic Strip Factory is covered in The Comic Strip Factory
Manual. If you've used The Comic Strip Factory with its
native characters, you shouldn't have any problems
putting together Comic People's characters.

You might skip ahead to Tips on Using the Characters
for specific information about each of the characters in
this set.

One special note. The props file is stored in MacPaint
format, unlike the props file in The Comic Strip Factory.
We did this for two reasons:

* You might want to make customized versions of the
background by adding the props in a Paint program, and

e Paint files are smaller than Parts files, and we were
running quite low on disk space.

If you want to use the props as comic parts, use the
PartMaker II program (included with The Comic Strip
Factory) to convert convert the file into a Parts file.

...with Other Graphics Programs

Comic People come in Comic Strip Factory Parts files,
except for the Office background and Office Props, which
are Paint files. To use the art in Parts files with programs
other than The Comic Strip Factory, you must convert the
parts files into Paint files. By Paint files, we refer to the file
format first used by MacPaint. A few other programs now
use this format as their only file type, and several
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applications and desk accessories can open Of save Paint

files in addition to their own file types.

' To convert the files, use the utility program
PartConvert on Comic People Disk 2. There isn't'enough
space to put the Paint files on the Comic People disks.
PartConvert doesn't erase the original Parts files, and we
recommend you keep the original disks intact in case you

urchase The Comic Strip Factory. S0 make sure you have

another disk available with adequate free space.
PartConvert works best with two disk drives or a hard

disk, but if you have only one disk drive, you can swap
disks as needed. It's easiest to convert all the files in one
session and not have to worry again about whether you
have the right file in the right format.

Here's how to PartConvert:
Double click on the program's icon from the Finder.

Two menus will appear on the menu bar: an Apple menu
for desk accessories and a Convert menu.

In the Convert menu are three commands: Convert
Parts to Paint..., Transfer..., and Quit.

To convert a Parts file, choose Convert Parts to Paint....
An Open dialog box will come up listing all available parts
files. If you need to, use the Drive button to switch to the
drive containing the file you want to convert. If you only
have one drive, you may have to use the Eject button to
eject the disk so you can insert the containing the file you
want. To start converting a file, select it in the scrolling list
and click the Open button.

A new dialog will come up as the program reads the
file. This dialog acknowledges the name of the file you
have selected and displays a thermometer showing how
much of the file has been converted. The conversion of a
single file should take less than a minute.
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If you have selected the wrong file, click on the Cancel
button and start again.

When the conversion is done, the program will bring
up a Save As dialog allowing you to enter the name for
the new Paint file and select a disk to save the file on. The
default name for the file is the name of the file converted
with the word Paint added to the end. Change the name if

ou want to, use the Drive or Eject button to select the
right disk, and click the Save button to save the file.

If for some reason the program can't save the file—the
most common reason being that the disk selected doesn't
have enough room—a dialog will appear explaining the
problem. After you have clicked OK, the Save As dialog
will appear again.

A list of programs compatible with Paint files follows.
Two of these, Art Grabber and Art Roundup, are desk
accessories that make Paint files useable from a variety of
other programs including draw programs, word
processors, databases, and desktop publishing software.
They're also useful with MacPaint, which only allows one
document open at at time.

Art Grabber is available as part of VideoWorks,
ComicWorks, and the MacroMind Utilities Disk (M.U.D.). .

Art Roundup comes with the WetPaint clip art series.
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Paint File Compatible Programs

Program Reads Writes Comment . -

Art Grabber Yes No Desk Accessory: Copies portions to
Paste into other programs.

Art Roundup Yes No Desk Accessory: Copies portions to

Paste into other programs. Sclcct with
rectangle or lasso. Some editing

ability.

The Comic Yes Yes Reads);or use as background. Co.n.verts

Strip Factory to Paint from comic format. Utility
converts Paint to Parts.

ComicWorks Yes Yes Reads via Art Grabber, included.
Converts to Paint from comic format.

FullPaint Yes Yes  DPaint program.

MacBillboard Yes Yes  Paint program.

MacPaint Yes Yes  TPaint program.

Paint Cutter Yes Yes Limited full-screen, multi-file editing.

PosterMaker Yes Yes  Enlarges to print out or save in multiple
Paint files.

SuperPaint Yes Yes Paint/draw program. Converts Paint to

and from mixed paint/draw format.

About The Comic Strip Factory

This note is for people who haven't purchased The
Comic Strip Factory. For the people who said to
themselves, “I want to use these great characters, but not
to make comics, so I don't need The Comic Strip Factory.”

You're right. The characters in Comic People can be
converted into Paint files and put together in any Paint
program. So you don't need The Comic Strip Factory.

If you really have a use for Comic People, however,
they're much easier to use with The Comic Strip Factory.
Even if your intended use for Comic People isn't to make
comics, The Comic Strip Factory can save you a lot of
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o it can save a document as a MacPaint file, The

: Inc - el 3
time. SI y is compatlble with just about

Comic Strip Factor
er thing. . : : .

= V}\;heth%er the artwork's ultimate destination is a
ok, greeting card, or advertisement, The

newsletter, bo se

Comic Strip Factory can help you prepare it in ways that

no other program can. Here's how:
Assembling characters. A character's parts in The

Comic Strip Factory are treated as separate objects. That
means you don't have to spend your time lassoing: you
drag parts into place. You can try out things

just point and | :
quickly and change your mind without hassle. Even if
you've already put a character together and decide that

ou want a different arm or head, you can just pluck the
offending part away and drag in a new one.

Compare this to paint programs where you have to
carefully erase the part you want to replace, lasso the
replacement and drag it into place, then spend a minute
or two touching up around the edges.

Many times you have to put one thing in front of, or
behind another. For example, heads should be in front of
bodies, or the neck will be hidden behind the shoulders,
and so on. Putting something in front is usually easy in a
Paint program, if the thing going in front is opaque when
lassoed. (Look carefully: is the object fully enclosed, or is
there just one little pixel missing? How much time have
you spent hunting for that one little pixel?) Putting
something behind something else can be a real problem.

With The Comic Strip Factory, it's always easy. Because
whether a part is opaque or partially transparent has
nothing to do with whether it's fully enclosed. The
background mask—the part that determines which part of
an.object is opaque and which is transparent—can be
edited in a FatBits-like mode just like the picture can! And
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with the Bring to Front and Send to Back commands, you
can change your mind about front-to-back ordering even

after you've constructed a character.
Dialog Balloons. Even outside of comics, Comic

People want to talk. And being Comic People, they tend to
talk in dialog balloons. And use a lot of bold and italic to
emphasize important words. Paint and draw programs all
have the ability to add text to a document, but most of
them can't mix fonts, styles, and sizes easily. And making

balloons around text can be a chore, too.
The Comic Strip Factory has the equivalent of a mini-

word processor built right in. Editing, font, style, and size
changes are all easy. Creating the balloon is even easier:
just click on one of the seven balloon types available,
including standard dialog, rounded rectangle dialog,
thought, and shouting styles, and the program makes the
balloon fit around the text automatically.

Working with a Background Picture. Let's say you
have a character, and you have a picture, and you want to
put the character in front of the picture. Easily done. Now
let's say you change your mind. Not so easy in a paint
program, because the part of the background picture you
put the character on has been wiped out. But with The
Comic Strip Factory, changing your mind is easy. You can
move the character, or use a different part of the picture,
or even change pictures completely, all without having to
start again from scratch or do a lot of painstaking erasing
and repairing.

Cropping. So you've made a character, put words in
his mouth, and put him in front of a background. But
now you want to crop the finished result. With a paint
program, you can crop things to any shape, as long as it's
rectangular. Just draw the rectangle over your picture and
erase around it. But if you want to crop to a circle, or any
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Uncle Donny's Debut

YEARS AGO | WAS
IN THE PEACE
CORPS IN
JAMAICA. IT WAS
A GLORIOUS

EXPERIENCE. =

i f[__“.” IT DID HAVE IT'S LITTLE ]
INCONVENIENCES. THE THIRD
WORLD DOES WITHOUT A

LOT OF THINGS THAT WE

TAKE FOR GRANTED. FOR
EXAMPLE, IT WAS IMPOSSIBLE
TO GET...MAYONNAISE. | L &

f S0 MY FRIENDS BACK IN
THE STATES TOOK TO
SENDING ME RECIPIES.
YIENOW, IF YO MAKE

YOUR OWN MAYONNAISE

YOU CAN FLAVOR IT ANY

POSSIBLY COOLD!

AND, AS YOU CAN SEE, | ENJOYED
EVERY BIT OF IT, AS OFTEN AS |
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WHEN CHRISTMA S CAME, 'WE AMERICANS |

POT ON A TALENT SHOW. AND ‘WOOULDN'T
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PARTICIPATE. 1 DECIDED TO PAY TRIBUTE
TO THE GLORIOUS REVOLUTION OF THE
PEOPLE OF CUBA BY THE FOLLOWING
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Further comments about putting people together can
be found in the Character Assembly comic in The Comic
Strip Factory Manual. But don't be too much of a
perfectionist. Remember, you're putting together comics.
Loosen up! Have fun! Getting the idea across is more v
important than absolute accuracy. And with a little |
practice, it gets a lot easier than it might seem at first.

You might find some parts you don't understand at
first. Don't worry. This isn't like putting together an
internal combustion engine. You can leave parts out
sometimes and it will still work. The artist has been
putting these characters together in hundreds of
combinations for months, as the characters were being
developed. If you keep putting them together, you'll
eventually find some bizarre pose where the mysterious
part fits right into place. Trust us.

Finding the Right Hand. Or, rather, the correct hand.

The files with hands all have them arranged in roughly
the save sequence. You don't need to memorize the order,
but being aware of the fact that there is a sequence might
make the right hand easier to find. From left to right,
you'll find pointing fingers and symbolic gestures, fists,
“doing” hands, holding hands, gestures, and extravagant
gestures. Toward the bottom to the right of center are
leaning hands, languid gestures, and hanging hands.

Remember that flipping or rotating a hand can give it
an entirely different look. You should also note that most
hands come in pairs: one in which a gesture is seen palm
forward, and another, rotated 180 degrees, showing the
same gesture from the back of the hand.

Arms and Hands. Arms in Comic People are rounded
at both ends. The wide end is the shoulder and the narrow
end is the wrist. Where hand and wrist meet, which one
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to put in front depends on whether the hand is aiming
toward the reader or away.

If the hand is toward the reader, overlap the rounded
end with the hand. If it's pointing away, put the hand
behind the wrist. Hands have cuffs attached, so the curve
of the end of the wrist will look like the curve of the cuff
from that perspective.

Some of the files contain what look like short arms.
These are for situations where either the upper or lower
arm is hidden by the hand or the body.

Finding the Right Face. This is a lot like finding the
right hand; maybe even easier.

Expressions run, from left to right, mild to extreme.
General emotional states are in rows. Happy is at the top,
then neutral, sad, angry, and scared. The “neutral” faces
are a catch-all group for special purpose expressions.

White Outlines. When used with The Comic Strip
Factory, most of the parts have white outlines around
them except where they are intended to join other parts.
The white outline helps the character stand out against
the background picture or pattern.

Special attention should be paid to some leg
combinations. Any of the side views of legs (especially in
the cases of Zane, the Straightman, and Uncle Donny)
where the rumps match can be overlapped, with either leg
on top, to good effect. Because we couldn't know in
advance how you would overlap legs, we couldn't erase
the appropriate white outline for all situations. After
you've put the legs together, look where they overlap,
bring the top leg into the EditBits screen, and erase that
part of the white outline.

Gray Ovals. Some of the legs files contain simple gray
ovals. These are for those cases where you attach bent legs
to the body and end up with an embarrassing hole
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between them. Just drop the gray oval behind them to fill
in the missing hips or rump.

The Guys. Sam, Steve, and Oliver have a lot of
interchangeable parts. The skinny legs in Nether Regions
go with either Steve or Oliver. The thicker legs with
shorts are Sams. Likewise, Steve's and Oliver's bodies and
arms are interchangeable. The feet in Nether Regions are
for all three of them, and also can be used with

Straightman.
Any of the guys heads can be used on Straightman's

body if you need one of them in a suit.
Sam and Steve can use each other's hands. Sam has no

Coffee cup or phone hand: use Steve's.

The ties in Steve's file can also be used by Oliver or
Sam. (They're always loosened to match the collars: these
guys are based on a programmer, a writer, and an artist.
They never follow the company dress code.)

You might choose to change the ties to patterned or
striped in EditBits if you want more variety.

Straightman. Straightman isn't a completely
developed character. He doesn't even have a real name.
He exists primarily as a foil for the other characters: the
classic comedy straight man. He's the boss who changes
his mind just before deadline or the middle manager who
insists on requisition forms in triplicate for pencils and
paper clips. His faces are pretty neutral, but they're so
simple that they're easy to change. Just play with the
mouth and eyebrows in EditBits (or FatBits in Paint
programs) to wring some more emotion from him.

Note: Because of a last minute change in file
arrangement, Straightman is on disk 1, but he appears on
the label of disk 2. All other characters can be found by

looking at the disk labels.
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Geri. Geri Byle-Whitler wears a jacket. While other
characters' bodies are whole, the jackets are divided into a
left and a right half. This allows you to put them closer
together or farther apart, or to mix and match halves. Plus
it lets you put one half over the skirt and the other half
behind it when the character is seated.

Don't feel you have to match the halves at the collar
perfectly because you'll be covering the seam with the
head and collar part.

If you're using The Comic Strip Factory, look at the
jacket halves against a background pattern other than
white. You'll see that there is an opaque white section
where the shirt shows through. Match the top of the skirt
to the bottom of this white section. Using the white area
as a guide helps you to avoid making her too elongated.

Legs and skirts follow a few simple rules. If she's
standing up, the legs knees should be covered by the skirt.
If she's squatting or sitting down, the bent legs should be
in front of the skirt.

Using the Office Background and Office Props

The Office file is MacPaint for use as a background file
in The Comic Strip Factory. It can be used in either
Portrait or Panorama mode. You'll note that the rooms it
represents are pretty barren. This is where Office Props
come in.

Office Props is a MacPaint file. It contains furniture,
props, and other details to add to the Office background.
You may choose to do this in one of two ways: in a Paint
program or in The Comic Strip Factory.

To add the details in The Comic Strip Factory, run the
Office Props file through PartMaker II to create a parts file.
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" A COMPLETELY NEW CAST OF COMIC PEOPLE! ft
CREATE THOUSANDS OF LIFE-LIKE POSITIONS!

Two disks, stuffed with characters and backgrounds!
Each character has dozens of heads, bodies, arms and
legs! Put 'em together any way you want! For comics,

ads, storyboards, pamphlets, newsletters and more!
. Use Comic People with any MacPaint compatible program!

Comic People and The Comic Strip Factory are trademarks of Foundation Publishing. Macintosh and
MacPaint are trademarks of Apple Computer, Inc. Mac the Knife is a trademark of Miles Computing, Inc.
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HyperCard's
To use such a comic with HyperCard, save it as a MacPaint file and use
Import Paint Command to load it into a HyperCard Stack. (See the HyperCard

documentation and help files for more details.)

Tips on Making HyperComics
You'll find that this method provi

HyperCard. Just Make a HyperComic in
as MacPaint. Make successive changes to the comic (move a character or

part, change a hand position or facial expression, and so on), and save each
version as a different MacPaint file. Using file names like Frame 1, Frame 2,

and so on will help you keep track of the sequence.

making frames of the animation, Transfer to HyperCard.
te a Comic Strip Factory button on your stack-in-
progress so you can get back and forth between Comic Strip Factory and
HyperCard more quickly.) Import each frame into a new card and step
through them to get the animation effect.

des an easy way to animate comics in
The Comic Strip Factory and save it

When you're done
(You may want to crea

If you have only made small changes from frame to frame, you might want to
Import the first frame into the background and each successive frame into a
card. Then erase the parts of each card that are the same as the background
and make those parts transparent. This will save you a considerable amount of

disk space.

nent can be opened by The Com wipl?gc@ ory: CM@, rip,

ng Open,,. brings up this dialog: " e .
This is a standard Open dialog with file

= type radio buttons and a New button

(& My Comics | added. Since The Comic Strip Factory

0 Mother's Day Comic 5, My Comics only keeps one of each window type
open at once, radio buttons for

[ Nerd Comis |
D Nerd Comin 11 document types already open are
D Nerd Comin 111 [ dimmed.

0 Wizard Comix A e
Open The scrolling list displays file types

selected by the radio buttons. To display
a list of another file type, click the radio

i

o Cancel btl”lit;lt'lon ﬁc;f the desired type. To open one
@ Comic Stri Part T of the files, click on the file name and
B ERarts  Otent click Open. To create a new file of the

selected type, click New.

Other Open dialog controls operate as described in your Macintosh al

. The
functions of some controls depend on whether you are using MFS ¢ HFS fil

H
and the number of drives attached to your Maci’ntosh. y 3

Transfer...

Since The Comic Strip Factory is designed to use data from other

included Transfer... in the File menu. This allows you to run anothg'r?)%zag;n:rhwvithout
quitting to the Finder. Like Quit, Transfer... asks if you wish to save open files before
exiting. "I‘his allows you to save changes, discard changes, or cancel the operation. If
you don't cancel, the standard Open dialog is displayed after all files are closed Ffom
this dialog you can select an application to run. \
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In conjunction with the Transfer... item in PartMaker II, you can move back and forth
between The Comic Strip Factory and PartMaker II quickly.

Edit Menu

Undo
Most actions in the Comic window and Parts window can now be undone with the

Undo command. Undoable actions include

* dragging,

¢ duplicating,

¢ deleting,

* Pasting, and

* all commands in the Object and Arrange menus.

Changes to panels, including changing the shape, background picture, or panel
pattern, can't be undone.

In addition to command-Z, the @ key is a shortcut for Undo.

Paste
Paste has been improved in two ways. Multiple objects can now be pasted from sources

outside The Comic Strip Factory, such as the Scrapbook and Art Grabber desk
k3 acceess
}; Iy" 7 'r':, ..3.

ed in as single recta .
& Which type of Paste— “Paste as multiple objects,” or “Paste as one object,” is
B determined by the picture on the clipboard and by keyboard modifiers.

Follow along, and we'll explain how it works.

Smart Paste :
Without a modifier key, Paste first tries to separate distinct objects in the picture. This

is useful if, for example, you create a set of parts (separate objects) in a paint program,
then paste them in all at once. If there are fewer than thirty-two parts on the
clipboard, Paste treats them as separate objects.

R

objec

After separating the picture into objects, Paste checks to see if any of the objects are
close to other objects. (“Close” means separated by only one white dot.) If the objects
are close together, you probably intended them as one object, not many separate
objects. And that's what Paste assumes. The neighboring objects are then merged
together before Pasting.

That's one way Smart Paste works. Here's the other way: If a picture on the clipboard
contains more than thirty-two distinct objects, the picture is Pasted as a single object
with a rectangular background mask. This is a handy way to use part of a MacPaint
picture as a panel background.

(Note: Smart Paste applies only to pictures pasted from outside The Comic Strip
Factory, not overlapping parts copied from within the program. Objects Cut or Copied
within The Comic Strip Factory will Paste as they originally appeared, unless modified
by a special Paste command, as described below.)

ries, MacPaint, and other pics programs. Also, complex images-ean fiow be ——
) PN 2 YN 2 1.;‘.;,‘_ ... : -3 : ‘ . . S

dl

; 4
:-{
i“ &
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Option-Paste
Option-Paste gives you more control over Paste.

while pasting, the clipboard is Pasted as a single part

-Paste converts the clipboard contents to a single

If you hold down the Option key
This applies to pictures cut from within The Comic

with a rectangular mask. Option
rectangular object before Pasting.
Strip Factory or from another source.

Subsequent Paste commands also paste this one object, unless modified by the shift
key as described below.

Note on using objects as background...
As we mentioned above, a single object with a rectangular mask is useful as an

alternate panel background.

Such an object isn't as a standard background, though. It should be “sent to

the back," or it will cover other objects in manel. Also, be careful not to ‘
send other objects behind it. The “background object” can still be selected 4
and moved as an object, so you won't be able to start a selection rectangle in :

that panel. ST kT AR
- v iy
Ly A .‘ N - oy A Ty ., 8 y s | A - i
+t he background obiject is in ro ‘the “real”
4 3 >

g e e S — S — e — -

You can, however, do this: Make a ;‘.ilhoueité of the object, bring the
silhouette in front of the object, select a pattern and whether to darken or

lighten from the Set Pattern... dialog.

This is one workaround to the limitation of one background picture per file.
Another workaround is to use a paint program to create a composite
background file from the desired parts of two or more existing background

files.

Shift-Paste
Shift-Paste is the opposite of Option-Paste. It tells the program to try harder to Paste

the clipboard as separate objects with fitted background masks.

If the clipboard contains objects copied from The Comic Strip Factory, Shift-Paste fi
, W t
makes the objects into a single picture, then attempts to separate thr'eym. i

Shift-Paste is somewhat different from the standard Paste command. Shift-Pa
. -Paste tri
lt;;l ﬁe;lgleo?)?éecgsts wit? ne:ighboring objecttg as each object is created instead of \:amrciz
_ are found. This means the -two object limi
e 5 e thirty ]| t is reached much later

Shift-Paste is useful when you want Paste to “try harder” to make separate objects.

Here's an example.

You use standard Paste with a picture from a Paint program. Yo
objects, but standard Paste interprets the cupboardpas a single urecmtang,toﬂapasmg:cte?amte
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To force the issue— to make Paste try harder to separate objects—try again with Shift-
Paste.
If the clipboard still pastes as a single object, try pasting fewer items at a time.

two objects. Using Edit Object...,

Shift-Paste is also useful for splitting one object into
ects. (Black bits of

erase enough of the object's black bits to simulate two separate obj
o dots.) It's not

the intended separate objects must be separated by at least tw
necessary to erase the white bits. Click OK. Copy the object to the clipboard then Shift-

Paste. The clipboard will paste in as two objects.

Like Option-Paste, Shift-Paste changes the contents of the clipboard to the set of
objects just pasted.

If both the Option key and the Shift key are held down while pasting, the Shift key will
be ignored and an Option-Paste will be performed.

Pasting Recap
Here again, in abbreviated form, are the various ways to paste:

Paste, if fewer than 32 objects, tries to paste as separate objects. Neighboring objects
are merged. If more than 32 objects, pastes as a single rectangular object.

Option-Paste pastes as a single rectangular object.

Shift-Paste {ries harder t0 paste as separate objects.

Dragging

Autoscrolling
This one's a convenience for comic construction. If the mouse pointer passes the

window edge while dragging objects, the window automatically scrolls. Autoscrolling
can be used in the Comic and Parts windows. You can also autoscroll while dragging

the outline of a panel in the Background window.

Destination Panel Display
While dragging objects in the Comic window, if the mouse enters a panel that isn't

selected, the panel is automatically selected. When the mouse button is released, the
program tries to place all restricted parts that were being moved into the newly
selected panel. Any parts that don't overlap the selected panel are freed from the

panel.

Font Notes

The System file on your Comic Strip Factory Program Disk contains several fonts
designed for comic strips. They are:

Beach 12
Beach Bold 12,14
Beach ftalic

12
N Emphats 2 14
f:»?:ou 05 12
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and fourteen point fonts, but the
top of the next) is tighter

st comic books and strips,

d to mimic the hand-lettered

The characters in these fonts are standard twelve
leading (the space between the bottom of a line and the
(there's less of it). This is consistent with lettering in mo
where space is at a premium. Also, the fonts are designe

styles of professional comic letterers.
There are a slew of special characters in these fonts. Here's a map of them.

[ oSie SR SRl SORKEE pek  SOBIG W 3Ry P4 T TER
1 2 3 4 5 6 7 8 9 0 L &
@ ek S TR - R~

w E 39

S > & 3 o W <
S D G H J K L

2z, SEEKIE Add M 2SaeLs ;.,u"\g e
Z X B M A ] /

Other special characters are on the @ key, which contains the character ¥*, and
Option-?, which displays 2.

Typically, you can't use fonts if they aren't in the current System file. So if you copy
Comic Strip Factory onto a hard disk or an 800K floppy disk, you should use Apple's
Font/DA Mover to copy the fonts into the System file on that disk. (Don't copy the
System and Finder from the CSF Program disk onto a hard disk!) - :

PartMaker II

PartMaker II replaces the PartMaker program described in your manual. PartMaker II,
like the former PartMaker,

» reads MacPaint files,
s converts MacPaint graphics into parts, and
¢ saves the parts for use in The Comic Strip Factory.

PartMaker II has been completely rewritten. It is about four times faster than the
earlier version. PartMaker II also displays the conversion process.

Because of these improvements, most of Rolling Your Own Parts on pages 22 and 23 of
your manual is obsolete.

Rolling Your Own Parts Version 2.0
PartMaker II “sees” a paint file as objects separated by white space. The objects are

converted to parts and copied to a parts file, which you can then name and save.
Before we discuss how it's done, let's define “paint file” and “white space.”

A paint file is any file MacPaint can open. But the file needn’t be created by MacPaint.
FullPaint, SuperPaint, MacBillboard, ComicWorks, The Comic Strip Factory, and most
graphic digitizers can save MacPaint files. Some of these products save paint files as an
option. Others, like MacBillboard and FullPaint, use paint files exclusively.
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Most clip art comes in paint files. Clip art is ideal for parts files because clip art objects
are surrounded by generous white space.

The white space is important. To PartMaker II, white space is “space separating
distinct objects.” That definition is used by PartMaker II to find graphic objects and to

create parts.

How PartMaker II Works
A paint file is scanned until a black dot is found. The object’s edge is then traced. The

edge is where white dots meet black dots. To PartMaker II, everything within the edge
is an object.

So far, PartMaker II is like an automatic MacPaint “lasso.”

Many comic parts, however, aren't tightly enclosed. Fred Nerd and Root Wiz, for
example, have wispy hair— potentially many, many separate objects!

To include those stray bits, PartMaker II looks at neighboring parts. If a neighboring
part is only one white dot away, the two parts are merged together.

When designing your own parts, remember that “white space” means “separated by
more than one white dot.”

You may find, though, that wisps are wispier than PartMaker II takes into account.
Remember, if stray dots are separated by more than one white dot, PartMaker II
makes them separate objects. To mierge thesé "sirays™ manually, € New

file into The Comic Strip Factory. Then drag a selection rectangle around objects that
may be several parts. If two or more animated marquees appear, select MergeBits from
the Objects menu. The MergeBits command “merges” the separate parts into one

object.

You may also find objects that aren't completely enclosed. White sections of these parts
may become transparent. To find the transparent areas, choose a gray background
pattern in the Parts window. To fix partially transparent parts, use EditBits.

Using PartMaker II
This is the easy part. Open PartMaker II from the Finder. Choose Convert Paint... from

the PartMaker 2.0 menu. Open a paint file. PartMaker II brings up this dialog:
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The paint file is at the left. As parts are found, they're copled to the right rectangle.
The thermometer shows the conversion's progress. The word above the thermometer

shows the conversion stage in grog'esa: “Tracing..." when the object's edge is being
traced, "Copying...” when the object is made into a part, and “Merging...” when other

parts are checked for possible merging,

You can press Cancel at any time to stop the process and save parts already converted.

When the entire paint file has been converted, or when you cancel, a Save dialog allows
you to save the new parts file to disk.

We hope you enjoy the new features of version 1.6. Many of them are the result of your
comments and suggestions,

If you have any comments about The Comic Strip Factory, or suggestions for further
improvements, we'd like to hear from you,



Merging...

0% 100%

Cancel

The paint file is at the left. As parts are found, they're copied to the
i~ 4leneemnematar shawe the conversion's progress. The word above



6436 City West Parkway, Minneapolis, MN 55344
(612) 942-2925

Comic People Join
The Comic Strip Factory

Minneapolis, MN— Comic enthusiasts wept with joy as Foundation
Publishing today announced “Comic People Vol. L” the first package of
additional art for The Comic Strip Factory.
SRS SanSRIz SCHOKES hek¥r FSOBIS SGIORIC 2

...Well, maybe we should just tell you about Comic People, and
skip the press release format!

Comic people is what Comic Strip Factory customers asked for:
More characters. Human characters. And that's what Comic People
are (is?): a completely new cast of seven characters in various sizes,

ages, shapes, sexes and races. As the package says:

A COMPLETELY NEW CAST OF COMIC PEOPLE!
CREATE THOUSANDS OF LIFE-LIKE POSITIONS!

Two disks, stuffed with characters and backgrounds!

Each character has dozens of heads, bodies, arms and legs!

—— __Put ‘e togetherany-way youwanti Forcomics, ads, -
storyboards, pamphlets, newsletters and more!

Use Comic People with any MacPaint compatible program!

The two-disk Comic People collection is $39.95. To purchase
Comic People, see your dealer, call MacConnection, or call us at
1-612-942-2925.

Here's a sample:

Office Days! ,
From the corridors of power... Mrs. B2 It's about 90 degrees
Ob, YEs out here! Could you just turn
it's a beautiful ma'ami

day, don't yoo
Ehink, Simmons?

el
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VEARS AGO I waS [ BUT IT DID HAVE IT'S LITTLE S0 MY FRIENDS BACK Iy

IN THE PEACE INCONVENIENCES. THE THIRD THE STATES TOOK TO

CORPS IN WORLD DOES WITHOOT A SENDING ME RECIPIES.

JAMAICA.IT WAS LOT OF THINGS THAT WE Y KNOW, IF YOU MAKE
A GLORIOUS TAKE FOR GRANTED. FOR YOUR OWN MAYONNAISE

EXPERIENCE. EXAMPLE, IT WAS IMPOSSIBLE YOU CAN FLAVOR IT ANY
4| TO GET...MAYONNAISE. WAY YOU LIKE! ... %,

P e S X 7

4 |
WHEN CHRISTMAS CAME, 'WE AMERICANS
POT ON & TALENT SHOW. AND WOOLDN'T
YOO KNOW, THEY INS/STEL THAT I
PARTICIPATE. I DECIDED TO PAY TRIBUTE
TO THE GLORIOUS REVOLUTION OF THE
PEOPLE OF CUBA BY THE FOLLOWING
gin. SONG: (AHEMZ)

EVERY BIT OF IT, AS OFTEN AS |

ND, AS YOO CAN SEE, I ENJOYED
POSSIBLY COULD!

JI'YEEATENONE TONO'
ASMAYOIGeale

$PAONE TONO'

MAAAAAAYYYYYYOO000007 !

I'VYEEATENONE TONO'
MAAAYYYO... %0y







